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1. Introduction
Congratulations on purchasing a Luma! You now possess the finest digital
camera back available today. The Luma is easy to learn and intuitive to
operate. The very best way to familiarize yourself with the Luma is to sit
down with your Macintosh and this User’s Guide and start at the
beginning.

After a short section on setting up your camera, you will find a Quick Start
guide that will have you up and shooting pictures in just a couple of
minutes. This is followed by a series of short sections that will help you
learn the Luma’s features in an easy, hands-on manner.

What You Need
Following are the hardware requirements for the operation of the Luma:

• Macintosh G3, G4 or better (desktop or portable) with built-in
FireWire capability

• OS 9 or newer (Note: Luma Studio does not yet work under OS X)
• 256 MB of RAM minimum
• Hard drive of 1GB or larger recommended
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2. Setting Up
Inside the Case
The Luma comes packed as follows:

• Luma camera back
• Personality plate
• FireWire cable
• IR filter
• Shutter release cable (green tag)
• Camera interface cable (red tag)
• Video cable (RCA plugs on each end)
• Macbeth™ ColorChecker® card

Putting It Together
The Luma attaches to a medium or large format camera using a
personality plate in a similar latch-and-hook method as a standard film
magazine.

Attaching the Luma

• Attach the personality plate that matches your camera body to the
camera.

• Attach the Luma to the personality plate:
1. Hold the latch on the left side of the personality plate open.
2. Place the Luma against the personality plate, first hooking the

right edge of the Luma inside the right edge of the personality
plate.

3. Release the latch, and the Luma should lock into place.

Installing the Luma Studio Software

The Luma Studio application software handles the processing of the
photographs taken with your Luma. This software includes all of the tools
you will need to develop, correct, enhance, and export your images. The
CD included with your Luma is used for installation. To install the
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application program, double-click the Luma Studio Installer and follow
the instructions on your screen.

Note: You will have to reboot your Macintosh after installing the software.

Note: Make sure your monitor’s color depth is set to “Millions” using the
Monitors control panel.

Setting up the Cables

• Attach one end of the camera interface cable (red tag) to the Luma and
the other end to the matching connector on the camera body.

• The FireWire cable connects the Luma to the Macintosh via FireWire
jacks on each end. This is a “hot pluggable” cable, so the computer’s
power can be on when you attach this cable. (If your Macintosh is on
when you plug in the Luma, the light on the back of the unit will
briefly flash red, then blue, then turn solid blue. If you start up the
Luma Studio software the light will turn green, indicating that the
Luma is connected to the software and ready for use.)

• (Optional) Attach the shutter release cable (green tag) to the matching
connector on the Luma.

IR Filter

Mount the IR filter on your camera lens. (An infrared [IR] rejection filter
is required for all CCD image sensors in order to render colors correctly.
You may use the Luma without the IR filter for special effects, or with an
IR transmitting filter for IR imaging.)

Now that your Luma is connected, you’re ready to try taking your first
shot, so let’s move on to the Quick Start section.
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3. Quick Start
Double-click the Luma Studio icon to launch the software. If this is the
first time you’ve run the software, you will be asked to perform a
calibration. You will learn more about the types of calibration for the
Luma later. For now, just click OK, and the software and the camera will
set themselves up.

You’ll see three windows on your screen. The large Image window will
display a full resolution view of the images that you shoot. The window
below it is the Contact Sheet window, which will contain thumbnail
representations of your images. You’ll use it to manage your different
images. The window on the right side of the screen is the Tools window,
where you can control your Luma and many of the other powerful
functions of the Luma Studio software.

If your Luma is connected and its light is green, you’re ready to shoot. Set
the camera’s controls just as you would when shooting with film. (If you
are using a Fuji GX 680 camera, set the mode selector switch to
“MULTI ”.)

To take a shot, either press the button on the shutter release cable or click
the Take Shot button in the camera pane of the Tools window. Try it now.

After a second, a thumbnail of your image should appear in the Contact
Sheet window. You’ll see a progress bar in the thumbnail as the image
Develops (more on Developing later.) When it finishes, your new image
will appear in the Image window in full resolution. It’s that easy!

The color in this shot may not look quite right, because we haven’t created
a Color Calibration file yet. We’ll do that next when we take a more
detailed look at the Luma Studio software.
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4. About Luma Studio
The key to photographing with Luma is to use the same techniques you
would use when you photographed using film. Your lighting and
positioning are as critical to successful shooting as they have always been.

Digital Images
When you take a picture with Luma, the first thing that happens is that the
image data is transferred from the camera back to the computer. Almost
immediately, a preview (or “thumbnail”) of the image is displayed in the
Contact Sheet window. However, the transferred image data needs to be
processed before it can be displayed in high resolution on the screen. This
processing is called Developing.

The undeveloped digital image is a lot like a film negative. It contains all
of the information to make the image, but it can’t be viewed fully until it is
developed. This image is often referred to as a high dynamic range (HDR)
image, which refers to the fact that it contains a full 16 bits of information
for every pixel.

Developing a digital image is a lot like developing a film image. You end
up with a “print”, a file of the original image that can be viewed on screen,
manipulated, edited, saved, and printed. If you ever lose this “print” or
want to make another copy, you can go back to the original negative – the
undeveloped HDR file – and develop it again to make another print.

Developing an image takes a small amount of time, and the results take up
more memory in your computer than the undeveloped image did. The
Luma Studio software gives you control over whether developing occurs
automatically as you take pictures, or manually, at a later time, under your
control. When you choose to defer developing, you’ll be able to shoot
more pictures faster; when you choose automatic developing, you’ll shoot
more slowly, but you won’t have to manually develop each image.
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When you Save an image with Luma Studio, you’re really saving the
undeveloped image. To save developed images you need to Export them,
which will allow you use them in other applications, like Adobe
Photoshop™.

Developing
The Luma Studio software lets you choose from three different developing
methods. (Remember, you can develop an image file as many times as you
like, and you can choose a different developing method each time if you
wish.)

Proof is the fastest method and is intended mainly for proofing purposes.
The idea here is to get your full image up on the screen as quickly as
possible.
Normal gives the best results for general purpose shooting, as it gives the
most evenly balanced, high quality image.
Enhanced is intended for subjects which exhibit color artifacts (such as
moiré), and enables sophisticated processing to minimize these artifacts.
Generally, you should choose this option only if “Normal” gives
unsatisfactory results.
Maximum uses a higher level of artifact suppression than Enhanced. Use
this method if Enhanced doesn’t do an adequate job of color artifact
removal.

Often, you will want to develop with Proof at first to get a quick look at
your image for color and composition, and then, when you’ve got the
shots you want, you can redevelop them in Normal or Enhanced mode for
the very best results.

Dark Calibration
Dark calibration plays an important role in digital photography. A dark
calibration file creates a record of an individual camera’s exact
performance under specific exposure conditions. Since this varies with
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each camera back for each exposure time, you must create a dark
calibration file for each exposure setting you wish to use.

When you first work with your Luma, it will perform initial dark
calibrations for the most common exposure timings. If you wish to use an
exposure time for which there is no dark calibration file, a small
warning will appear in the Camera pane of the Tools
window.

To create a dark calibration file, set the Exposure slider to the desired
setting and choose Create Dark Calibration from the Camera menu.

Color Calibration
Color Calibration files are profiles that are customized to each camera and
lighting condition. You’ll want to create a new color calibration file
whenever you shoot under different unique lighting conditions: tungsten,
fluorescent, etc. The Luma Studio software lets you save and select
multiple calibrations, so it’s easy to keep different files for different
lighting conditions.

Here is the process:

• Have a clean, unmarked Macbeth™ ColorChecker® card (shipped with
your Luma) ready as your target, and set up your lighting prior to
beginning the calibration. The gray patches on the Macbeth card
should be on the bottom and the photo area should be evenly lit.  Take
a well-exposed image of the target.
Tip: In a well-exposed image, the spot meter values in the white patch
should read between 200 and 240 using the Factory tone curve.
Tip: Be careful to insure that the Macbeth card is not tilted
significantly, and that it occupies approximately 25% of the image
area.

• Develop the image.

• Select the Color Calibration Tool    and click once on the white
patch in the lower left-hand corner of the chart.
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• Calibration measurements and processing will take place automatically
and a dialog box will appear prompting you to name the calibration
file.
Tip: Choose a name that will help indicate the type of lighting
conditions under which you performed the calibration.

• When the calibration is complete, your image will redevelop
automatically using the new color calibration.

Pull down the camera menu and look at the submenu under Color
Calibration. The calibration you just created will be listed there, with a
check mark indicating that it is now the active calibration. Any new
images you shoot will be developed using the calibration indicated in this
list unless you specify otherwise.
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5. Using Luma Studio
This chapter is composed of a series of short sections, each designed to
teach you about a specific aspect of the Luma Studio software.

Image Window
The Image window is very simple to use, but there are a few tricks which
make working with your images easier. Start out by either taking a shot
with your Luma, or by loading an image that you’ve already saved.
Develop it so that the full resolution image appears in the Image window.

To Develop an image:
• Click on its thumbnail in the Contact Sheet window to select it.

Tip: The thumbnail background will turn a darker color when it is
selected.

• Click on the Develop button or select Develop from the Image menu.
You’ll see a progress bar appear on the thumbnail as the image
develops.

Select the Zoom tool   , and click on the image in the Image window a
few of times to zoom in. Now press and hold the spacebar while watching

the cursor. See how it changes to the Hand tool   ? While you’re still
holding down the spacebar, click and drag to move to different parts of the
image. This is a handy way to navigate around the image.

As you move the mouse around the window, the values in the lower left
corner change to reflect the pixel that is currently under the cursor.
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Tip: You can use the small popup menus next to the coordinates and pixel
values to change their units.

Tip: You can also click on the small    and    icons in the top right
corner of the window to zoom in and out without having to switch to the
Zoom tool.

Contact Sheet Window
The Contact Sheet window provides an easy place to control all of the
images you are working with during a particular session.

In the example above, the bullet (•) next to the name “Ryan Silk” indicates that the image has not been saved
since it was last changed. If you see a diamond (◊) next to the title, this indicates that the image has been
developed.

Try shooting or loading at least two images in Luma Studio. Click on one
of the image thumbnails in the Contact Sheet window. It will turn beige to
indicate that it is selected. Now hold down the Shift key and click on the
second image. Now both images are selected. Click the Develop button to
develop both images.

If you look closely, you’ll see that one of the two selected thumbnails is
slightly darker than the other. This is the image that you selected most
recently, and is referred to as the Current image. The Current image shows
in the Image window when it is developed.
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Try holding the cursor over the image name in one of your thumbnails. A
small popup window will appear with information about that image. The
pane in the top right corner of the Contact Sheet window also shows
information about the Current image. You can choose what information is
displayed here by selecting from the popup menu to the right of the pane.
You can also click on the pane itself to quickly cycle from one field to
another.

If your images are all saved, let’s clear the out the thumbnails. Choose
Select All from the Edit menu and click the Remove button.

Tip: If you try to Remove an image that hasn’t been saved yet or has been
altered since it was last saved, Luma Studio will prompt you to save your
changes. If you are in a hurry and are sure you don’t want to save the
images you are removing, hold down the Option key before selecting
Remove. You’ll see the title change to Remove!, and the software will
discard the image(s) without prompting.

Tools Window
The Tools window provides you with various tools to both control your
Luma and also edit the images that you shoot. These tools are separated by
function into different panes. If you aren’t using a particular pane, you can
save screen space by collapsing it with the small control in the top left
corner.

Expanded Pane Collapsed Pane

Tip: If you hold down the Option key while expanding or collapsing a
pane, all of the panes will follow.
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You can also drag the panes into any order you prefer. To drag a pane,
move the cursor over its title. When the cursor changes to the hand cursor

  , click and drag the pane to the desired position.

Session Settings Pane
The Session Settings pane is a very powerful means of streamlining your
shooting with the Luma. You can choose from a number of different
actions that will be performed automatically whenever you shoot a new
image.

If you know you want to see each image right away in its full resolution,
select Develop New Images. If you’re sure you want to keep each image
you shoot, you can select Save New Images to keep the HDR file and/or
select Export After Develop to export a TIFF file of the image.

Tip: When you automatically export an image, Luma Studio will export an
8-bit TIFF.

If you’re going to be shooting a lot of images, choosing Remove After
Save or Export is a handy way to preserve memory and prevent the
Contact Sheet window from becoming too cluttered with images.

Let’s play with the Session Settings now. Set up your Luma to shoot some
new images. Click on the Name button in the Session Settings pane and
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the Default File Name dialog will appear. This dialog allows you to select
a file name that will be applied to new images as you shoot them. Luma
Studio will add either the date and time to the file name or an index which
simply counts the shots you take. You can change this default file name
whenever you want.

Click on the Folder button and select a folder where you want your new
images to go. You can also create a new folder if you want. Note: Images
are only saved into this folder automatically if you have selected Save
New Images or Export After Develop.

Make sure Save New Images  is selected and try shooting a few images.
Now go take a look in the folder you created. You will see the HDR files
of each shot you took, automatically saved for your convenience.

Camera Pane
The camera pane lets you control your Luma directly from the Macintosh.

Orientation

The orientation popup allows you to match the image orientation to the
Luma’s orientation. Match the location of the green LED on the popup
menu with the location of the green LED on your Luma, and your images
will be captured exactly as you see them through the viewfinder.
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Sensitivity

Set the sensitivity as you would with regular film. The choices are ISO 25,
50, 100, and 200. Just like with film, you’ll get best results using the
lowest ISO settings.

Exposure

Set the Exposure slider to reflect the current shutter speed of your camera.
• If the shutter speed is faster than 1/4 second, set the Exposure slider to

“1/1000 – 1/4 second” (this would be the normal setting for strobe
photography.)

• For longer exposures, set the Exposure slider to the value that most
closely matches the camera’s shutter speed.

• For “bulb” exposures, the Exposure slider setting will control the
speed of the camera’s shutter.

Take Shot

Click this button to take a shot with your Luma.

Live Video Pane
The Luma’s live video feature is very useful for shot composition. You
can view live video on either your computer’s monitor or on an auxiliary
monitor with video input (NTSC or PAL), which you connect to the Luma
using the video cable provided. You should set the shutter speed on your
camera to B. Select the desired video outlet from the popup menu, check
the Video On checkbox, and the image will appear on your screen.

Tools
The Luma Studio tools perform various functions, from improving the
color of your images to aiding scene composition, to simply getting a
closer look at the pixels in the image. Let’s go through them one by one to
learn their different features and tips.
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Hand  

The hand tool is very basic. Just click and drag on the image in the Image
window to move it around.
Tip: When another tool is active you can temporarily switch to the hand
tool by holding down the Space bar.

Zoom  

The Zoom tool lets you magnify or reduce your view. To zoom in, click
on the area you want to magnify. Each click will increase the
magnification of the image. To zoom out, hold down the Option key. You
will see the center of the cursor change from + to –. Now, clicking on the
image will reduce its magnification.
Tips:
Zoom to Fit: If you hold down the F key while clicking the zoom tool, the
view will change to a size that fits the whole image in the window.
Show 100%: If you hold down the 1 key while clicking the zoom tool, the
magnification will change to exactly 100%.

Zoom Actions: The buttons in the Zoom Actions section allow you to
quickly fit the image to the window, zoom to 100%, go to Full screen view
mode, or match all zooms.

The Match all zooms button sets the magnification level and location to
the same exact point for all images. This is very helpful when you want to
compare a specific area on two or more similar images.

Crop  

The Crop tool allows you to trim unwanted areas from your images. To
use it, drag a rectangle onto your image and select the Crop command
from either the Image menu or from the Crop Settings section of the Tools
window. When you crop, all of the areas outside of your crop rectangle
will be permanently removed from your image.
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There are a number of different ways you can define your crop rectangle.
They are available in the Crop Settings section:

• Fixed Size: This feature is helpful when you want the final image to be
a specific size. Enter values for the width and height in the edit fields
provided. Now, when you click on the image to place your crop
rectangle, it will remain the specified size.

• Fixed Ratio: This feature works similarly to Fixed Size, except that the
ratio of the width to the height is constrained, rather than the actual
size of the crop.

• Color: If the crop rectangle is hard to see against the background of
your image, you can choose a different color.

• Crop Settings: If you have defined a specific crop rectangle and want
to use it with other images, you can choose to Save it here in the crop
settings popup. Any saved crops appear in this popup list and can be
activated for an image by simply selecting them from the popup menu.

• Clear: Click here when you want to remove your crop rectangle from
the image.

• Crop: Click this button when your crop rectangle is exactly where you
want it, and your image will be cropped.

Tape Measure  

This tool can be used to measure images and to resize them. To use it,
click and drag on a portion of your image. You’ll see a tape measure line
appear on your image. When you release the mouse, the size of the line
you measured will appear in the Tape Measure Results section.

If you wish to resize your image, you can then click the Resize button. A
dialog will appear that allows you to enter a new size. The image will be
resized at the same resolution so that the distance you measured on the
image matches the new distance you entered in the Resize dialog. Note:
You can only resize an image to a smaller size.

Tip: For a perfectly straight horizontal or vertical measure, hold down the
Shift key while you are dragging out the tape.
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Grid   

You can utilize this tool to display an imaginary grid over your image.
This can be helpful when composing a shot or aligning different elements
of an image. Just click on the Grid tool and the guides will appear on your
image.

The Grid Settings allow you to show or hide the grid, specify its size and
color, and even save it so that you can recall it quickly for other images.

Use as default: This button allows you to specify the current grid as the
default grid for all new images. (This will not apply to images that have
already been saved.)

Tip: If you hold down the Option key while you click and drag your grid,
you can alter its spacing directly on the image.

Tip: If you prefer just ONE horizontal and/or vertical line to use as a
crosshair, set the grid spacing to a large value and save it. Whenever you
need a crosshair, just select this item from the Grid Settings popup.

Gray Balance  

The Gray Balance Tool allows you to compensate for slight color casts in
the tones of your image. For example, if an object should be gray but
appears to be slightly tinted, you can click on it with the gray balance tool.
This will change the color balance of the entire image so that the spot you
clicked appears gray.

Tip: If you want to use more than one point to define a gray balance for
your image, hold down the Shift key while you click on the image. Each
Shift-click will add a point to those being used to balance the image.

Gray Balance Settings
The popup menu gives you three choices for the gray balance for your
image:
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• None: Don’t balance the image at all.
• Default: Use the default saved gray balance. (This item is only

available if you have saved a default gray balance.)
• Custom: Use the custom gray balance defined for this image. (This

item is only available if you have defined a gray balance for this
image.)

Use as default: Pressing this button will save the current gray balance as
your default.  This gray balance will be applied automatically to all new
images.

Loupe  

You can use the loupe tool to quickly examine sections of your image at a
1:1 ratio. Just select the tool and click on an area of interest on the image.
You can move the loupe view around on the image by clicking and
dragging it. To hide it, click the X in the top left corner of the loupe view
itself, or click the Hide Loupe button in the Loupe Settings section.

Spot Meter  

This tool gives you the ability to mark a single location on the image and
view the color values for that spot. If you click on the image with the spot
meter, you will see a small red rectangle appear on the image. The Image
Info pane will display the pixel information for the spot you selected. You
will also see the red, green and blue points marked on the tone curve
display.

Spot Meter Settings
You can choose different sample sizes by choosing from the spot size
popup.
Use the Clear Spot Meter button to clear the spot meter from the image.

Color Calibration  

Use this tool when you are ready to start a color calibration. See Chapter 4
for a detailed explanation of the color calibration process.
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Toning

About Toning

An important aspect of imaging with Luma is the concept of Toning. The
tone curve controls the appearance of the picture by adjusting the
relationship among shadows, midtones, and highlights. (Tone curves are
also referred to as process curves, transfer curves, and color curves.) The
toning panel of the tools window displays the tone curve, along with a
histogram, which depicts the relative frequency of pixel lightness values in
the image.

The tone curve transforms every input (or capture) pixel value to an output
(or export) pixel value. Input pixel values are what the Luma sees. Output
pixel values are what the Luma Studio software shows you on your
monitor. Input values are measured in f-stops, from 0 (white) to negative
infinity (black). Output pixel values are in units between 0 (black) and 255
(white).

A tone curve is quite similar to a photographic D log-E curve. The
difference is, with Luma, you can change it however you wish.

Pushing the Tone Curve

Pushing the tone curve means moving the entire curve left or right by a
small amount. This push has the effect of changing overall brightness.
Pushes are measured in f-stops. A push of +1, for example, has the same
brightness effect as opening up the camera’s aperture by one f-stop. You
can push the curve by clicking on the arrows in the push control. Single
clicks adjust the push by 1/2 f-stop. Holding down the Shift key while
clicking changes the increment to a full f-stop. Holding down the Option
key while clicking reduces the increment to 0.1 f-stops.

Pushing is helpful in compensating for small deficiencies in lighting, but
not for large ones. You’ll get the best results when you light your subject
just as you would with film.
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Selecting a Tone Curve

Tone curves can be named and saved, and can be recalled for use by
selecting them from the Curves pop-up menu. There is always at least one
named curve: the Factory curve. This is the curve that comes with your
Luma; you cannot alter it or delete it. Otherwise, any curve that you edit,
name, and save appears in the menu.

Tone Range Highlighting

You can use tone range highlighting to better understand the how a
histogram relates to your image, and to determine whether certain areas of
the image are underexposed or overexposed.

Dragging across an area of the histogram will cause that area to be
highlighted with a highlight color. As you do, all the pixels in the Image
window that contain input pixel values in that histogram range will be
highlighted with that color. You can drag multiple ranges using the Shift
key.

Tip: You can personalize the highlight colors by double-clicking on any
highlighted range in the histogram.
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Editing a Curve

To edit a tone curve, click the Edit button to bring up the Tone Curve
Editor window.

• The horizontal (X) axis represents the 16-bit values for brightness
stated as relative f-stops ranging from 0 (white) to -infinity (black).
These are called capture values.

• The vertical (Y) axis represents the 8-bit values ranging from 0 (black)
to 255 (white), called export values.

• The curve has three movable points that control critical tonal regions
of the image: the shadows, midtones, and highlights. If you click on
one of the points you will see the specific locations for its X and Y
values.

• The shadow point controls the conversion of dark pixel values. An
example would be a 16-bit capture value of –5 f-stops to an export
value of 15. Below this point, an image will usually have limited
shadow detail or texture.

• The midpoint point charts the midrange values. An example of this
would be a capture value of –2.5 f-stops to an export of 128, which is
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the center of the 8-bit range. The position of the midpoint control point
is where an 18% gray card would appear in the histogram.

• The highlight point charts the brighter pixel values. An example would
be a capture value of –1 f-stop to an export value of 240. Tones above
240 have limited color, texture, and detail.

• You can click and drag any of the control points. You will see the
effect immediately in the Image Window. If you move a control point
up or left, this will brighten the portion of the image affected by the
particular control point. If you move a control point down or right, this
will result in a darkening of that area.

• If you want to adjust the brightness of the curve, hold down the Option
key while dragging a point. To adjust the contrast, hold down the
Command key.

• If you don’t like the result of a tone curve change, you can remove it
by selecting Undo Tone Curve Change from the Edit menu. Redo is
also available. You can Undo and Redo repeatedly if you wish.

Saving and Deleting Curves

You can save the current tone curve by selecting Save Tone Curve from
the Curve popup menu. To delete a saved curve, choose Delete Tone
Curve.

Using Saved Curves

To activate a saved curve, choose the name of the desired curve from the
popup menu. It will be immediately applied to your image. Note: If you
don’t like the result, choose Undo Tone Curve Change from the Edit
menu.
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Creating Multiple Exposure Images
Selecting this command allows you to produce a multiple exposure image
using two existing images. You must have two images of identical size
and orientation open and selected to use this feature. In the Contact Sheet
window, select the two images you wish to combine. Select the Multiple
Exposure menu command.

You can choose between four different multiple exposure effects in the
Effect popup menu. An explanation of each one will appear in the text
below the menu. Click OK to go ahead and create a multiple exposure
image.

Note: Your original images will not be affected when you create a
multiple exposure image. An entirely new image is created.

Scaling Images
If you wish to scale an image in Luma Studio, select the image and choose
Scale Image from the Image menu.
A dialog will appear which allows you to specify a new size for the image.
Note:You can only scale your images to a size that is smaller than the
current image.

Full Screen View Mode
Full Screen View is a valuable feature when you want to concentrate on
your images and forget about all the tools and windows normally
associated with working with a computer. To try it out, shoot or load an
image, and develop it. Select Full Screen View from the Window menu.

All of the distracting windows will go away and your image will fill the
screen. This is a very handy time to remember your keyboard shortcuts
(Appendix B). Press Z to select the Zoom tool. Hold down the 1 key and
click on your image. This Zoom tool shortcut zooms your image to 100%
view. Now hold down the space bar to temporarily switch to the Hand tool
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and click and drag your image. To zoom back out, hold down the Option
key while clicking with the Zoom tool.

To exit Full Screen View, press F or the Escape key.

Preferences
The preferences dialog lets you control various settings for new Luma
images and how images are exported.

Default resolution for new images

Use the edit field and popup menu to set the pixel resolution for your new
images.

Default develop method for new images

Sets the default develop method for new images that you shoot. See
chapter 4 for more information on Developing.
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Default tone curve for new images

This popup menu allows you to choose which tone curve is automatically
applied to your new images. There is a standard Factory tone curve
included with the Luma Studio software, but if you have saved your own
tone curves in Luma Studio, you can select them here as your preferred
default.
Dynamic: This is a special setting for expert users. If you select Dynamic,
whichever tone curve was last used on any image will be applied to your
new image. This allows an expert user who is taking a series of similar
shots to easily tweak the curve as the shots progress until the desired curve
is found.

Allow tone curve editing

Disabling this option allows you to “lock out” manual tone curve editing.
When tone curve editing is disabled, the user cannot access the Tone
Curve Editing window. (They can still select different saved tone curves in
the Toning pane of the Tools window, and can change the brightness of
the curve using the Push buttons. See the Toning section of the Tools
window for more details.) This can be useful in a professional studio
setting, for example, where specific tone curves have been saved and
defined for use by the studio, but manual editing of curves by individual
users is not desired.

Open exported files with

This feature allows you to choose which application that will be used to
open your exported files. This is the application that will launch
automatically if you double-click a TIFF file that has been exported from
Luma Studio.

Labeling Images

This feature allows you include a label on images that you export from
Luma Studio. This can be handy when creating proofs to make it easier to
track the images you shoot. You can select what specific information is
included by checking the desired items.
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Tip: You may want to fill in the fields for Photographer and Copyright
Note. These fields are saved with each Luma image as well as appearing
as labels on Exported images.
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A. Menu Reference

File Menu

Open

This command allows you to open an existing image file. You can select
the types of images available for viewing and can preview an image before
it is opened. You can also choose how you wish the image to be loaded.
Normally, when you load an image, it will be loaded into memory but not
developed. If you check Develop after opening, the image will be loaded
and then developed automatically.

Close

Selecting this option will close the front-most open window.

Save and Save As

These are standard Macintosh commands that allow you to save a new
image and name it for storage on your hard drive. Save As allows you to
save an existing image under a new name or in a new location.

Export as TIFF

When you select this command, you can save an image as a TIFF (Tagged
Image Format File) for export to another application. It is suggested that
you export using the 8-bit TIFF option, as this is the most widely used
format.

Export Proof Web Site…

This command allows you to create a quick web site with proof-sized
previews of all of your images. The files for the site are saved to your
local hard drive where they can be easily copied to the internet or written
to a CD for easy distribution.



Luma Studio Manual  |  35

Revert

You can select Revert to reload the last saved version of the currently
selected image. Any changes you have made to the image since it was last
saved will be discarded.

Print

Print the currently selected image.

Print Selected

Print all selected images.

Print Contact Sheet

You can print out the contents of the Contact Sheet window at any time by
selecting this command.

Quit

Select this command to exit the Luma Studio application.

Edit Menu

Undo / Redo

These are standard Macintosh menu commands that usually undo or redo
the last action performed by the user. In Luma Studio, they are used to
undo or redo corrections applied to the Tone Curve. Tip: You can select
Undo and Redo multiple times to remove or replace as many Tone Curve
corrections as you wish.

Cut, Copy, Paste and Clear

These are standard Macintosh menu commands that often apply to text
editing. They work on text within Luma Studio as they do with most text-
editing applications.
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Select All

When you are working in the Contact Sheet window, this command allows
you to select all of your images. This can be helpful when you wish to
perform the same action on each image.

For example, let’s say you are taking shots rapidly and, to save time, want
to wait to develop them until you have finished shooting. When you are
finished with the series of shots and are ready to develop them, choose
Select All and then select Develop. All of your shots will develop
sequentially. You can also use Select All followed by Remove to clear all
of the images from the Contact Sheet to make room for more. Tip: If all of
the images are already selected, Select All will deselect all of the images.

Preferences

Brings up the preferences dialog. See Chapter 5 for detailed information
about the various preferences.

Image Menu

Develop

Use this command to Develop images that you have selected in the
Contact Sheet window.

Develop With...

This command allows you to use a different Develop Method or Color
Calibration file to develop an image (or images). Note: Although you can
always redevelop an image with any Develop Method, when you develop
an image with a new color calibration, the color calibration that was
associated with the image is discarded.

Remove

This command will remove the selected image (or images) from the
Contact Sheet. If you have made any changes to the image, you will be
prompted to save them before it is closed.
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Tip: If you hold down the Option key, the command will change to
Remove! This command works exactly the same way, but will remove the
images without prompting you to save changes. Use care when employing
this option.

Crop

The Crop command is available when you have drawn a crop rectangle on
your image using the crop tool. Selecting this command will crop the
image to the rectangle you have drawn.

Scale Image

Selecting this command will bring up the Scale Image dialog, which
allows you to specify a new size for the image. Note: In this release of the
Luma Studio software, you can only scale your images to a size that is
smaller than the current image.

Set Export Resolution

Selecting this command will bring up the Scale Image dialog, which
allows you

Clear Crop, Clear Gray Balance, and Clear Spot Meter

Selecting any of these options will clear the current selection for that tool
in the Image window. For example, if you have a spot meter defined and
choose Clear Spot Meter, the spot meter will be removed from the image
window.

Show/Hide Grid

This command allows you to show or hide a grid on the image in the
image window. The various grid options are controlled using the Grid tool
and the Grid Settings in the Tools window.

Hide Loupe

This command allows you hide the Loupe view if it is being used in the
Image window.
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Show/Hide Tone Range Highlights

Both the Toning pane in the Tools window and the Tone Curve Editor
window allow you to select different portions of the histogram and see the
corresponding pixels highlighted in the Image window. This command
allows you to temporarily hide the highlighted pixels without having to
clear the tone range. This feature is explained more fully in the Tools
section.

Multiple Exposure

Selecting this command allows you to produce a multiple exposure image
using two existing images. Remember: you must have two images of
identical size and orientation open and selected to use this feature. For
more information on the Multiple Exposure feature, see Chapter 5.

Camera Menu

Take Shot

Select the Take Shot command to capture an image with Luma.

Special Shots

Retake Shot

When you are setting up a scene, you will often take and discard a
number of shots before everything is set to your liking. Retake Shot
will replace your last shot with a new one, preventing the need to
constantly remove unwanted images.

Read Last Shot

You can read the last image you shot from the Luma with this
command. This can be useful if you accidentally discarded the image
from the Contact Sheet, or wish to have two copies of the same image.

Add Pop to Previous Shot

Choosing this option will add a shot to the last one taken. This makes
“building up a shot” much easier.
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Take Multiple Pop Shot…

This feature works similarly, but you can specify ahead of time how
many shots to add together, and what time interval elapses between
shots.

Timed Shots…

The Timed Shots feature allows you to automate shooting a series of
images. You specify how many shots to take and how long to wait
between each shot.

Color Calibration

This submenu allows you to choose from among the different available
color calibrations. The current calibration, which will be applied to any
new images you shoot with the Luma, is checked.

Creating Color Calibrations...

If you need a reminder on how to perform the new Luma Studio color
calibration, select this item for step-by-step instructions.

Delete Color Calibrations...

Allows you to easily delete color calibrations that you no longer need.

Color Management Settings...

Allows you to turn on the ICC color management environment and specify
parameters such as color spaces and rendering intents. For more details,
see Color Management Options in Appendix B.

Create Dark Calibration

If you want to create a dark calibration for a particular exposure speed,
select the desired exposure and choose Create Dark Calibration. The Luma
will perform the calibration and you will see a message indicating the
calibration is complete. You will need to perform a dark calibration for
each custom shutter speed you use.
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Window Menu

Zoom In / Zoom Out

Select these commands to increase or decrease the current magnification
of the image.

Channels

You can use the Channels sub-menu to display the individual red, green,
and blue channels of your image. The normal mode is RGB, which
displays all three channels.

Full Screen View

This command can be useful when you have a shot displayed in the Image
window and you want a full view of your image with no other distractions.
When you select Full Screen View, you’ll see the screen go black and
your image will fill the screen. To exit Full Screen View, simply press F
or the Escape key.
Tip: You can use all of the usual tools in Full Screen mode. It can be
helpful to know the keyboard shortcuts here: See Appendix B.

Image Window, Contact Sheet Window, Tools Window, Live Video Window

Selecting any of these commands will open the specified window if it is
closed, or bring it to the front if it is hidden.

Clean Up Windows

This command will move the three main windows to their original default
positions.
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B. Color Management Options

Using ICC color management
Luma Studio 1.7 allows you to use ICC color management, which may
improve your ability to get consistent color with the Luma, especially
when you are working with applications other than Luma Studio.

When you use ICC color management, you should make sure that your
computer monitor is accurately calibrated and profiled.  That way, Luma
Studio will be able to display colors accurately to match either the original
scene or, optionally, printed output.

To turn on ICC color management, select the Color Management Settings
command in the Camera menu, which will bring up the Color
Management dialog.
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Check the “Use ColorSync ICC Workflow” option, and then configure the
additional options for color spaces, rendering intent, and quality.

Color Management Options
Workspace Specifies the color space that is

used internally for Luma
images and for certain exports.

Choose a wide-gamut color
space, such as “Adobe RGB
(1998)”

Output Specifies the color space that
will be used for final (printed)
output, and for certain exports.

Choose the color space that
corresponds to your desired
output device.

Rendering Intent Specifies the way in which
out-of-gamut colors are
mapped into the Workspace or
Output color spaces.

Refer to ColorSync
documentation for advice.

Quality Specifies the quality level of
color space transformations.

Use “best” for best results.
Use other settings for faster
performance.

Simulate Output
On The Monitor

Controls “soft-proof”
functionality.

Check to enable “soft-
proofing”, which allows you to
see an simulation on the
monitor of what the final
printed output will be.  Note
that proper monitor calibration
and profile selection is critical
for this feature to work well.

Exporting Using ICC Workflow

If you have ICC Workflow enabled, you will have extra options when you
export pictures.  As always, you can choose between 8-bit and 16-bit TIFF
exports:

• With a 16-bit TIFF export, you can choose the color space for the
export among Workspace, Output, and Raw. You will usually want
to choose either Workspace or Output. Choosing Workspace
generally gives the best results, because it uses a high-gamut color
space.

• With 8-bit TIFF export, you are limited to Output. (Both
Workspace and Raw color spaces require 16-bit pixel sizes.)
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Important Notes

After you make changes to the Color management Settings, you will
need to re-Develop images in the Contact Sheet. Until the images are
re-Developed, they may not appear correctly.

Developing images takes longer when you have ICC Workflow turned
on.

Using ICC Workflow restricts your ability to apply Toning adjustments
to your images.  With ICC Workflow enabled, the Tone Curve changes
to “Factory (ColorSync)”, and Editing the curve is disabled.  (You will
be able to “push” the curve, but you will not be able to adjust contrast.)
This restriction assures that color matching works as well as possible.



44  |  Luma Studio Manual

C. Keyboard Shortcuts
Tool Selectors:
Hand H
Zoom Z
Crop C
Tape Measure T
Grid G
Gray Balance B
Loupe L
Spot Meter S
Color Calibration X

Command Keys:
Open   O Remove   R
Close   W Remove! (No

warning)
 R

Save   S Clear Crop   K
Save As  S Clear Gray Balance   B
Export as TIFF   E Tone Range

Highlights
  ‘

Quit   Q Zoom In   =
Take Shot   T Zoom Out   -
Clear Spot Meter   M Channel – RGB    ‘
Show/Hide Grids   K Channel – Red   1
Hide Loupe   L Channel – Green   2
Undo   Z Channel – Blue   3
Redo   Z Full Screen View   F
Select All   A Image Window   N
Preferences   ; Clean Up Windows   /
Develop   D
Develop With   D
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